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About This Bulletin

Objective
This bulletin provides documentation updates for the Cisco ICM Enterprise Edition Release 5.0(0). This 
bulletin consists of corrections for documentation defects that have been discovered in the user 
documentation set for Cisco ICM Enterprise Edition Release 5.0(0).

Audience
Anyone using Cisco ICM Enterprise Edition Release 5.0(0) user documentation.

Organization
This document is organized as follows:

Chapter Description

Chapter 1, “Cisco ICM 
Enterprise 5.0 (0) 
Documentation Updates”

Provides list of defects for the Cisco ICM 
Enterprise Edition Release 5.0(0) documentation 
set and updated information for each.
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About This Bulletin
Conventions
Conventions
This manual uses the following conventions:

Other Publications
For more information about Cisco Intelligent Contact Management (ICM) software, see the Cisco ICM 
documentation web page.

Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several 
ways to obtain technical assistance and other technical resources. These sections explain how to obtain 
technical information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Format Examples

Boldface type is used for user 
entries, keys, buttons, and folder 
and submenu names.

Choose Design—>Retrieval Arguments 
from the InfoMaker menu bar.

Italic type indicates one of the 
following:

• A newly introduced term

• For emphasis

• A generic syntax item that 
you must replace with a 
specific value

• A title of a publication

• A skill group is a collection of agents 
who share similar skills.

• Do not use the numerical naming 
convention that is used in the 
predefined templates (for example, 
persvc01).

• IF (condition, true-value, 
false-value)

• For more information, see the Cisco 
ICM Software Database Schema 
Handbook.

An arrow (—>) indicates an item 
from a pull-down menu.

The Save command from the File menu is 
referenced as File—>Save.
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About This Bulletin
Documentation Feedback
Documentation DVD
Cisco documentation and additional literature are available in a Documentation DVD package, which 
may have shipped with your product. The Documentation DVD is updated regularly and may be more 
current than printed documentation. The Documentation DVD package is available as a single unit. 

Registered Cisco.com users (Cisco direct customers) can order a Cisco Documentation DVD (product 
number DOC-DOCDVD=) from the Ordering tool or Cisco Marketplace.

Cisco Ordering tool:

http://www.cisco.com/en/US/partner/ordering/

Cisco Marketplace:

http://www.cisco.com/go/marketplace/

Ordering Documentation
You can find instructions for ordering documentation at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

You can order Cisco documentation in these ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product documentation from 
the Ordering tool:

http://www.cisco.com/en/US/partner/ordering/

• Nonregistered Cisco.com users can order documentation through a local account representative by 
calling Cisco Systems Corporate Headquarters (California, USA) at 408 526-7208 or, elsewhere in 
North America, by calling 1 800 553-NETS (6387).

Documentation Feedback
You can send comments about technical documentation to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front cover of your 
document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Cisco Product Security Overview
Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html

From this site, you can perform these tasks:

• Report security vulnerabilities in Cisco products.
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About This Bulletin
Obtaining Technical Assistance
• Obtain assistance with security incidents that involve Cisco products.

• Register to receive security information from Cisco.

A current list of security advisories and notices for Cisco products is available at this URL:

http://www.cisco.com/go/psirt

If you prefer to see advisories and notices as they are updated in real time, you can access a Product 
Security Incident Response Team Really Simple Syndication (PSIRT RSS) feed from this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

Reporting Security Problems in Cisco Products
Cisco is committed to delivering secure products. We test our products internally before we release them, 
and we strive to correct all vulnerabilities quickly. If you think that you might have identified a 
vulnerability in a Cisco product, contact PSIRT:

• Emergencies— security-alert@cisco.com

• Nonemergencies— psirt@cisco.com

Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product to encrypt any sensitive 
information that you send to Cisco. PSIRT can work from encrypted information that is compatible with 
PGP versions 2.x through 8.x. 

Never use a revoked or an expired encryption key. The correct public key to use in your correspondence 
with PSIRT is the one that has the most recent creation date in this public key server list:

http://pgp.mit.edu:11371/pks/lookup?search=psirt%40cisco.com&op=index&exact=on

In an emergency, you can also reach PSIRT by telephone:

• 1 877 228-7302

• 1 408 525-6532

Obtaining Technical Assistance
For all customers, partners, resellers, and distributors who hold valid Cisco service contracts, Cisco 
Technical Support provides 24-hour-a-day, award-winning technical assistance. The Cisco Technical 
Support Website on Cisco.com features extensive online support resources. In addition, Cisco Technical 
Assistance Center (TAC) engineers provide telephone support. If you do not hold a valid Cisco service 
contract, contact your reseller.

Cisco Technical Support Website
The Cisco Technical Support Website provides online documents and tools for troubleshooting and 
resolving technical issues with Cisco products and technologies. The website is available 24 hours a day, 
365 days a year, at this URL:

http://www.cisco.com/techsupport
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About This Bulletin
Obtaining Technical Assistance
Access to all tools on the Cisco Technical Support Website requires a Cisco.com user ID and password. 
If you have a valid service contract but do not have a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Note Use the Cisco Product Identification (CPI) tool to locate your product serial number before submitting 
a web or phone request for service. You can access the CPI tool from the Cisco Technical Support 
Website by clicking the Tools & Resources link under Documentation & Tools. Choose Cisco Product 
Identification Tool from the Alphabetical Index drop-down list, or click the Cisco Product 
Identification Tool link under Alerts & RMAs. The CPI tool offers three search options: by product ID 
or model name; by tree view; or for certain products, by copying and pasting show command output. 
Search results show an illustration of your product with the serial number label location highlighted. 
Locate the serial number label on your product and record the information before placing a service call.

Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 
and S4 service requests are those in which your network is minimally impaired or for which you require 
product information.) After you describe your situation, the TAC Service Request Tool provides 
recommended solutions. If your issue is not resolved using the recommended resources, your service 
request is assigned to a Cisco TAC engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the Cisco TAC by telephone. 
(S1 or S2 service requests are those in which your production network is down or severely degraded.) 
Cisco TAC engineers are assigned immediately to S1 and S2 service requests to help keep your business 
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has established severity 
definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your business operations. You 
and Cisco will commit all necessary resources around the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your 
business operation are negatively affected by inadequate performance of Cisco products. You and Cisco 
will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most business operations 
remain functional. You and Cisco will commit resources during normal business hours to restore service 
to satisfactory levels.
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Obtaining Additional Publications and Information
Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or 
configuration. There is little or no effect on your business operations.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various online 
and printed sources.

• Cisco Marketplace provides a variety of Cisco books, reference guides, and logo merchandise. Visit 
Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

• Cisco Press publishes a wide range of general networking, training and certification titles. Both new 
and experienced users will benefit from these publications. For current Cisco Press titles and other 
information, go to Cisco Press at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and 
networking investments. Each quarter, Packet delivers coverage of the latest industry trends, 
technology breakthroughs, and Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, certification and training 
information, and links to scores of in-depth online resources. You can access Packet magazine at 
this URL:

http://www.cisco.com/packet

• iQ Magazine is the quarterly publication from Cisco Systems designed to help growing companies 
learn how they can use technology to increase revenue, streamline their business, and expand 
services. The publication identifies the challenges facing these companies and the technologies to 
help solve them, using real-world case studies and business strategies to help readers make sound 
technology investment decisions. You can access iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

• Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering 
professionals involved in designing, developing, and operating public and private internets and 
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

• World-class networking training is available from Cisco. You can view current offerings at 
this URL:

http://www.cisco.com/en/US/learning/index.html
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C H A P T E R 1

Cisco ICM Enterprise 5.0 (0) Documentation 
Updates

 Cisco ICM Software Release 5.0 Scripting and Media Routing 
Guide

Caveat ID: CSCsa33339

Update date: 3/22/05

Caveat Headline: Changing calltype information is incorrect in 5.0 Scripting & Routing Gd

Document Section: Categorizing Contacts topics: “How to Change the Call Type and Execute a 
Different Script” and “How to Change the Call Type and Continue Script Processing”

Document Pages:37-39

Symptom: The following Categorizing Contacts topics are incorrect:  “How to Change the Call Type 
and Execute a Different Script” - Incorrectly states you need to use a Call Type node when it should state 
you should use a Requalify node.  “How to Change the Call Type and Continue Script Processing” - 
Incorrectly states you need to use a Requalify node when it should state you should use a Call Type 
Node. 

Correction(s): Categorizing Contacts topic corrections:  “How to Change the Call Type and Execute a 
Different Script” - You can change the Call Type of a contact from within a script and execute a new 
script associated with the new Call Type by using the Requalify node (in the Routing tab of the Palette).   
“How to Change the Call Type and Continue Script Processing” - You can change the Call Type of a 
contact from within a script and continue processing in the same script by using the Call Type node (in 
the Routing tab of the Palette). 
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WebView Help
WebView Help
Caveat ID: CSCsa32086

Update date: 3/22/05

Caveat Headline: Description of agent Direction incorrect in webview online help

Document Section: WebView Help

Document Pages: N/A

Symptom: The description of the Direction field in the agent report templates says that “other meaning 
outgoing internal tasks,” which is inaccurate, and does not explain what a “null” direction is. 

Correction(s): The following is the description of the Direction field in the agent report templates: 
Direction The direction of active task: In (inbound task - non voice tasks are always inbound) Out 
(outgoing external task) Other (outgoing or ingoing internal task) Not Applicable (if the logged in agent 
is not active in the skill group) Derived from: Agent_Real_Time.Direction

Caveat ID: CSCsa21271

Update date: 3/22/05

Caveat Headline: Help confusing, misleading for longest task in queue

Document Section: perskg20: Peripheral Skill Group Status Real Time Report 

Document Pages: N/A

Symptom: In the help for WebView report template perskg20: Peripheral Skill Group Status Real Time 
Report, the Longest Task Queued column is incorrectly described in terms of media domains.

Correction(s): The correct definition of this column is the longest task queued in either of two queues: 
Skill_Group_Real_Time.RouterLongestCallInQ or Skill_Group_Real_Time.LongestCallQ.

Caveat ID: CSCsa18613

Update date: 3/22/05

Caveat Headline: We should doc how to turn on the printing of the background rpt colors

Document Section: N/A

Document Pages: N/A

Symptom: Internet Explorer, by default, does not print background colors and images, which means that 
the dark gray header backgrounds and the lighter gray row backgrounds in reports don't print. For a truly 
WYSIWYG report, users should turn on “Print background colors and images” in IE under 
Tools->Internet Options->Advanced->Printing. 

Correction(s): Turn on “Print background colors and images” in IE under Tools->Internet 
Options->Advanced->Printing.

Caveat ID: CSCsa19053

Update date: 3/22/05

Caveat Headline: Derived from help for Agent State Hold Time in Agent24 temp wrong

Document Section: agent24:Agent Performance Summary Daily Report

Document Pages: N/A
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WebView Help
Symptom: The “Derived From” information for the Agent State Times: Hold Time field on the WebView 
reporting help page for agent24: Agent Performance Summary Daily Report is incorrectly stated as 
Agent_Skill_Group_Half_Hour.IncomingCallsOnHoldTimeToHalf. 

Correction(s): The correct Derived From information for this field is Derived From: 
Agent_Skill_Group_Half_Hour.HoldTimeToHalf.

Caveat ID: CSCma30037

Update date: 3/22/05

Caveat Headline: More Info help misleading when it comes to some reports

Document Section: “About Half-Hour Intervals and How They are Computed”

Document Pages: N/A

Symptom: The instructions in WebView reporting help for specifying a half hour interval do not state 
that you need to specify the seconds. If you specify an interval in hours and minutes only, the report is 
missing the data from the last minute of that interval. For example, if you specify “10:00 - 10:29” the 
report is missing the data from 10:29:00 to 10:29:59. 

Correction(s): Include the seconds when specifying a half-hour interval. For example, specify 
“10:00:00 - 10:29:59” rather than “10:00 - 10:29”. 

Caveat ID: CSCsa32091

Update date: 3/22/05

Caveat Headline: No webview online help for AHT in Perskg24

Document Section: Template description of the “perskg24: Peripheral Skill Group Performance 
Summary Daily Report”

Document Pages: N/A

Symptom: The WebView report help for the AHT field in the “perskg24: Peripheral Skill Group 
Performance Summary Daily Report” is missing. It belongs in the WebView help after the description 
of the ASA field. 

Correction(s): The following is the description of the AHT field in the perskg24 report template: AHT 
The average handle time in HH:MM:SS (hours, minutes, sections) it took for calls to be handled during 
the current 24-hour interval. See also the WebView online help topic “About Half-Hour Intervals and 
How They are Computed.”   Derived from: (SUM(Skill_Group_Half_Hour.HandledCallsTimeToHalf)) 
/ (SUM(Skill_Group_Half_Hour.CallsHandledToHalf). 

Caveat ID: CSCsa24191

Update date: 3/22/05

Caveat Headline: perskg23,24 - %Utilization has wrong online help

Document Section: WebView Help

Document Pages: N/A

Symptom: The description of “”% Utilization” in the “perskg23: Peripheral Skill Group Performance 
Summary Half Hour Report” and the “perskg24: Peripheral Skill Group Performance Summary Daily 
Report” contains a formula which is the derivation of the field. The “Derived from: 
Skill_Group_Half_Hour.PercentUtilizationToHalf” section is incorrect. 
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Cisco ICM Software Database Schema Handbook and ICM Schema Help
Correction(s): The following is the description of the “% Utilization” field in the perskg23 and 
perskgv24 report templates: Agent State Times: % Utilization The percentage of time the agents spent 
working on calls in relation to the time agents are ready. Derived from: If the Talk_Time_to_Half is 0, 
then the % Utilization = 0  Otherwise, % Utilization =((Skill_Group_Half_Hour.TalkInTimeToHalf    
Skill_Group_Half_Hour.TalkOutTimeToHalf    Skill_Group_Half_Hour.TalkOtherTimeToHalf   
Skill_Group_Half_Hour.WorkReadyTimeToHalf   
Skill_Group_Half_Hour.WorkNotReadyTimeToHalf)/ (Skill_Group_Half_Hour.LoggedOnTimeToHalf 
- Skill_Group_Half_Hour.NotReadyTimeToHalf)).

Caveat ID: CSCsa20474

Update date: 3/22/05

Caveat Headline: remove Outbound fields from persvc26,27 templates

Document Section: templates persvc26: Peripheral Service  Historical All Fields Report and persvc27: 
Peripheral Service Real Time All Fields Report pages

Document Pages: N/A

Symptom: The help for report templates persvc26: Peripheral Service Historical All Fields Report and 
persvc27: Peripheral Service Real Time All Fields Report lists several Outbound Option only columns. 
These columns are actually not applicable. They are not populated with data during Outbound activity 
because Outbound Option does not provide data for services, it is skills based.

Correction(s): Do not use columns designated as Outbound Option Only in these reports.

Cisco ICM Software Database Schema Handbook and ICM 
Schema Help

Caveat ID: CSCsa32334

Update date: 3/22/05

Caveat Headline: Misinformation in definition of Version field in Script table

Document Section: Chapter 2: Table Details > Script Table > Version field and ICM Schema Help: 
Script Table topic “Version” field description

Document Pages: Schema Handbook Chapter 2, page 2-193, N/A for Help

Symptom: The Schema help and manual both state the description of the Version field as follows: 
VERSION - The most recent version of the master script. ICM software uses only the most recent 
version. This is incorrect. A user *can* set Script Editor to “Automatically make a script active when 
saved” but it would be incorrect to state that the highest version of a script is ALWAYS the active version.

Correction(s): Schema Help file and Schema manual both state in the definition of the Version field of 
the Script table that “ICM software uses only the most recent version.” For several versions of ICM, it 
has been possible to revert back to make a previous version of the script the “active” version. 

Caveat ID: CSCsa52522

Update date: 3/22/05

Caveat Headline: description in some of schema fields need to change
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Cisco ICM Software IP Contact Center Installation and Configuration Guide
Document Section: Chapter 2: Table Details and ICM Schema Help: all Table Lists topics

Document Pages: Multiple chapter 2 pages (all half-hour table field descriptions), N/A for Help

Symptom: Description in some of schema fields need to change.

Correction(s): Many Half_Hour table fields include a description that say: "....The value is updated in 
the database when the [some agent event]..." In reality, the database is updated every half hour but OPC 
counts the field when the event happens. These descriptions should say:  “....The value is counted when 
the [some agent event]...” This applies globally to many fields in the schema help file. For Example: 
Skill_Group_Half_Hour ConferencedInCallsToHalf   The number of incoming calls skill group agents 
were conferenced into. Incoming calls include ACD and non-ACD calls. The value is updated in the 
database when the agent drops off the call or the call becomes a simple two-party call.

Caveat ID: CSCsa20805

Update date: 3/22/05

Caveat Headline: CalltypeID = -1 for VRU TCD

Document Section: Chapter 2: Table Details > “Termination_Call_Detail Table” (page 2-261) > 
"CallTypeID" field (page 2-278) and ICM Schema Help:  "Termination_Call_Detail Table" topic > 
"CallTypeID" field

Document Pages: See above for Handbook pages, N/A for Help

Symptom: The ICM Schema help for the Termination_Call_Detail table does not fully document the 
conditions under which the CallTypeID field can generate a value.

Correction(s): The CallTypeID field contains a value if the call was translation-routed or sent to an 
IPCC Enterprise agent, or if a Termination Call Detail (TCD) record is generated by a VRU peripheral. 

Cisco ICM Software IP Contact Center Installation and 
Configuration Guide

Caveat ID: CSCma26085

Update date: 3/22/05

Caveat Headline: DN not found if RONA and Agent are not on the same pim

Document Section: Configuring Agent Desk Settings

Document Pages: 5-2

Symptom: Ring no answer calls fail to receive proper retry treatment.

Correction(s): IPCC Enterprise. Common agent desk setting is used across peripherals, and they 
reference a Ring no answer DN that is required to be peripheral specific. When this agent desk setting 
is used for an agent on a peripheral that different from the one the ring no answer DN is on, the ring no 
answer route request will fail. Create agent desk settings that are peripheral specific.
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